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Multiple Versions of e-Mail Notify

e-Mail Notify for Windows 95 and Windows NT is a shareware. Please read information about registration.

e-Mail Notify is released in four different versions. This topic will explain you why this was necessary, 
which version you should use, and what the differences are.

Why Four Versions

Despite the arguments of portability claimed by Microsoft, getting a application to work on all Windows 
system is a very hard task, especially if you want to use the latest features of the Operating Systems.

e-Mail Notify uses specific features of the Windows 95 shell, and also makes use of Multi-Threading for 
better performance. Since Win32s and Win16 doesn’t support Multi-Threading there was a need for a 
specific Win32s version. I didn’t intent to write these ports, but some people asked me for it.
Windows NT 3.5 does not include all the stubs for the New Shell APIs of Windows 95. For this reason, the
Windows 95 version of e-Mail Notify cannot run in Windows NT 3.5. Some people out there wanted e-Mail
Notify although there are running Windows NT, so I wrote the NT 3.5 port. Please note that you should 
use the WIN95 version if you are using Windows NT 3.51 or later.

Which Version to use

If you run Windows 3.1, then you should use the Win32s version. This version needs win32s 1.30 to 
operate properly (particularly for this help file).

If you run Windows NT 3.5 use the Win NT 3.5 version.

If you run Windows 95, Windows NT 3.51, Windows NT 4.0, or anything more recent than this, then use 
the Windows 95 version.

Differences between Versions

If you do not have a Multi-Threading system, e-Mail Notify is much less stable and well-behaving. In this 
case, be very careful not to ask him something that you know won’t work. In addition, the Win32s and 
Win16 versions are almost not tested, because I hate running “Good Old Windows” now that I use 
Windows 95. For this reason, the Windows 3.1 versions are provided free of charge.

If you do not run a system which has a Windows Taskbar (like Windows 95 or Windows NT 3.51 with the 
Shell Preview), you won’t see the nice Notify Icon in this Taskbar and won’t be able to hide e-Mail Notify.
In addition even if you are running Win95, if you run the Win32s or Windows NT 3.5 version, you won’t 
have access to these features either.

The Remote Access features are only supported in Windows 95 or Windows NT but not in Win32s and 
Win16.

The best way to run e-Mail Notify is to run the Windows 95 version in Windows 95 ! You will have access 
to all the features of the application !

If    you do not have the right version you can get some information here on where to find the latest 
version on the Internet.
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What's new in e-Mail Notify version 1.20

This topic reviews the most important changes in e-Mail Notify from version to version. 
Lot’s of these changes are due to the users remarks to enhance e-Mail Notify.
I want to thank them for this.

New e-Mail Notify Web Pages and Author e-Mail Address:

Web: http://www.pobox.com/~ldubost/english/notify/index.html
e-Mail: ldubost@pobox.com

Version 1.20

Links to e-Mail Notify’s web site have been added to the help menus.

The testing period system has changed to a “run” based mode instead of timing.

Other memory leaks have been detected in e-Mail Notify and in Windows 95 and workarounds have been
found. I’ve made not very long tests of memory consumption and believe that this version is safe.

Additionally many annoying behavior bugs have been corrected (dialog boxes not getting in front, 
message boxes errors, cancel in delete message). 

e-Mail Notify will now remember window sizes and positions.

The main message view has been changed to a list view control in the Windows 95/NT versions. This 
allows you also to change the font type and size for it. All the parameter for the list view are saved.

Remote Access Dial-in is now supported in Windows NT.

A Windows 3.1 version is now back in and has been tested using Trumpet.

Version 1.11

A memory leak has been detected and corrected. The memory leak is in Windows 95’s Socket 
Implementation and I had to change the way e-Mail Notify is build to avoid the problem. Thanks for the 
users who reported the problem. Without them I would never have tracked this problem which appears 
only when e-Mail Notify runs a very long time. 

The Win32s and Windows NT version are fixed and do not report errors anymore ! This was a problem 
with the Visual C++ 4.0 upgrade. I had to switch back to Visual C++ 2.2 to compile the Windows NT and 
Win32s versions.

Some minor behavior changes have been made to make e-Mail Notify a little easier to use.

Version 1.10

The most important change is the support of Windows 95 Dial-Up Networking. Automatic dialing and 
hanging up is now possible. I installed a SafeGuard to be sure e-Mail Notify will stop Mail Checking if it is 
not finished after 7 minutes.



Some bugs and behavior changes have been corrected. You can now enter your password on each 
transfer if you do not want the password to be saved. There is also a “Start Hidden” option so it is no 
longer necessary to use a command-line option. Passwords are now more safely encrypted.

Version 1.01

Minor bug fixed in the welcome screen of version 1.0. Welcome WAV removed.

Version 1.0

Two new bugs have been fixed. The first probably made notify unusable on 16 bit systems, since the 
pooling timer didn’t work and made notify check every minute instead of the time chosen. The second 
bug was with some POP3 server. Notify would not notice the mail waiting on the server.

I also added a welcome dialog box to remind users that this program is shareware. Registered users will 
be notified how to bypass the dialog box. 

Version 0.99.11

I made a horrible mistake in the 0.99.10 version which made it bug for a lot of people out there. Here is a 
fix. It should resolve the connection problem many people had. Thanks to all the people who reported me 
this problem.

Version 0.99.10

Version 0.99.10 fixes yet another win16/win32s bug, some people had with connecting to the POP3 
server. It should work much better now. I made a different Help File for Windows 3.1 systems, since it 
doesn’t support the Help System. It would look as nice, and I still have to remove some unsupported 
links, so do not be surprised if the Help File looks weird.

Two new functions have been added. “Quick View” and “Quick Delete”. Check out the right click on the 
Mail headers or the Mail Menu to view and delete mail. I included maximum security in this function. 
Notify will verify the mail header before deleting to be sure to delete the right mail. 

Version 0.99.9

This version is now a shareware. If it suits your needs, please send me 5$ in the mail at Ludovic Dubost, 
9 Av du Colonel Bonnet, 75016 Paris, France (stamp is 50c) and send me an e-mail to register.

A new version for Win16 has been introduced. The same warnings apply as for the Win32s version. 
Please test it and tell me how it works and which configuration you run.

One new feature and many bug fixes for this version. Thank you to the people who helped me and tested 
version 0.99.8.

The new feature is the ability to run an external application every time there is new mail. This looks like 
running the external reader, but is a little more powerful, since notify is able to add the number of mails in 
the command-line. If you want more information about this, jump to the corresponding topic.

Bug fixes allow the win32s version not to hang your system, like it was the case before. My apologies to 
those who had problems with it. This version should now be okay and up and running like the NT and 



Win32s versions (the user interface will still be a little less responsive because of the monothreading).

Another bug that has been fixed is the popup menu from the tray icon, that was not behaving properly. 
Thanks to Felix Andrews from Microsoft (author of FlexiCD from the Windows 95 PowerToys available at 
http://www.microsoft.com/Windows/), it now behaves properly. 

The last bug is the one that cost me the most mail. It was a mistake in the documentation. To start notify 
hidden, you have to use the /H switch and not /U. Additionally, switches are not case sensitive anymore.

Version 0.99.7

Main rewrite of e-Mail notify. The MFC 3.1 Socket classes were used and a tabbed dialog box replaced 
the options dialog box. Wishes from e-Mail notify users were included in this version.

These include the possibility of launching an External Mail Reader. Error Checking has been improved. 

I slightly changed the behavior of the application following the advice of certain users. Now, the only way 
to really exit the application is to select Exit in the File Menu or in the popup Menu on the Tray Bar icon.

All other usual windows exiting ways will only hide e-Mail Notify, but the application will still be active in 
the Tray Bar. Of course, this only applies to the Windows 95 version.

Version 0.99.6

Many bugs fixed. New icons from John Stephens added (see credits). 

Win32s and Windows NT 3.5 version have be written.

Switches have been included to give the possibility to start e-Mail Notify hidden and to have more than 
one notifier running with different configurations.

Note: Windows NT 3.51 can use the Windows 95 version, especially if the are running the New Shell 
Preview. Everything should work fine. 

Version 0.99

First public release. 
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About e-Mail Notify

The main reason why I wrote e-mail notify is to reduce the mail transfer bandwidth from my mail server to 
my home pc. Since I needed to have access to my mail when I was at school, I wanted to keep my mail 
folders on my unix account. Also, Microsoft Exchange is a heavy program just to check if I have new mail.
That’s the reason why I wrote a very simple header retrieval program to be informed about new mail 
without really touching the mail. I know that some people out there have the same need as I have even if 
they have a computer directly connected to the Internet (not through PPP or SLIP). 

The second reason, was that I wanted to put some icon of mine in this nice tray bar Microsoft included in 
Windows 95. I tried to think of what I could put there and came up with the notifier idea. 
Finally, some people using NT or Win32s wrote me to ask me for a version that would work with their 
system. The port to NT was not to difficult but the Win32s was and is still quite a pain because the notifier 
uses multi-threading which is not included in Win32s.

Now that you got e-mail notify, if you are able to use it, this means you have e-mail. If this is the case, just
take a few minutes to contact me and tell me what you think. It is always nice to hear about people using 
your software. 

e-Mail Notify is now a shareware, which means that you have to    register and    fulfill    your part of 
the License Agreement if you want to continue using it after the evaluation period.
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About the Author

My name is Ludovic Dubost, I’m 26 years old. I’m coding now on Windows or UNIX computer for some 
time now. You can find some information about what I did and maybe new stuff on my web page at 
http://www.pobox.com/~ldubost. 
It’s a good place to thank Mathieu (alias mc, alias Tortle) for hosting my pages there. Go and visit the 
olympe WWW server at http://www.netsurf.org/.

See How to contact the author
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About e-Mail Notify’s Web Pages

The most recent information about e-Mail Notify is available from its Internet Web Pages. There are some
direct links to interesting areas in the Help Menu of e-Mail Notify of the Tray Menu.

The following links might be of interest:

Author Home Page http://www.pobox.com/~ldubost/
Home Page http://www.pobox.com/~ldubost/english/notify/index.html
FAQ http://www.pobox.com/~ldubost/english/notify/faq.html
Download Page http://www.pobox.com/~ldubost/english/notify/download.html
Registration Information http://www.pobox.com/~ldubost/english/notify/register.html
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License Agreement

Read carefully all terms of this License agreement before using this Software. If you do not agree with 
any term of this agreement, stop using this software immediately.    
 
1. Ludovic Dubost grants to you a non-exclusive, non-sublicense, license to use this version of E-Mail 

Notify for 30 days. Once this period expires, you will have to register the software. Registration 
information is available on the Internet at http://www.pobox.com/~ldubost/english/notify/register.html

2. You agree that this software and its source code is property of its author, Ludovic Dubost, 9 Av. du 
Colonel Bonnet, 75016 Paris, France.    
 
3. The Author makes no representations about the suitability of this software. The Software is provided 
'As Is' without express or implied warranties, including warranties of merchantability and fitness for a 
particular purpose or noninfringement. The author shall not be liable under any theory or any damages 
suffered by you or any user of the Software.    
 
4. The author grants you the right to redistribute this software, as long as you are not charging ANY 
money for it and the distribution files are kept together and unmodified. 
 
The distribution files are: 
 
                email.exe
                email.hlp
                email.cnt (Win95 and Win32s)
                email.txt 
                newmail.wav 
                FILE_ID.DIZ
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Credits

I first would like to thank Johns Stephens for the icons of e-Mail Notify, which wouldn’t be so nice, if he 
hadn’t drawn them. If you like his work, you can contact him at johns@ccnet.com through e-mail or visit 
his World Wide Web Home Page at http://www.ccnet.com/~johns/.

I also need to thank all the people who wrote me e-Mail about the program and gave me advice how to 
enhance it. I did my best to write most of the changes they asked me. I also wrote the Windows NT and 
Win32s versions because of them. Continue to write me and ask me for changes.
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File Menu

Clear Main Window

Select this menu command to empty the Headers window of e-Mail Notify. If you do this, it will force a 
complete re-load of the headers by e-Mail Notify.

Exit

Select this menu command to end your e-Mail Notify session. Note that double clicking on the system 
Menu or on the Windows 95 cross won’t end your notify session, but will hide the window. The application
will still be active and you will be able to control it through the Tray Icon. This command is also available 
in the Tray Menu.
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Mail Menu

Options

Choose this Menu Item to open the options Dialog Box, which will allow you to configure e-Mail Notify. 
This menu is also available in the Tray Menu.

Disable/Enable

This Menu command will allow you to enable or disable e-Mail Notify’s automatic mail checking option. It 
is the same as checking or unchecking this option in the Notify Tab of the options dialog box. This menu is
also available in the Tray Menu.

Check Mail/Stop Mail Transfer

This Menu command will allow you to start or stop a Mail Transfer. This menu is also available in the Tray 
Menu.

Run External Reader

This Menu allows to start the external Mail reader as configured in the Reader Tab of the Options Dialog 
Box. This menu is also available in the Tray Menu.

View Current Mail

This Menu is to quickly view a mail. This will download the beginning of the currently selected mail in the 
view window and display it.

Delete Current Mail

This Menu is to permanently destroy a Mail from your POP3 Server. Handle with care. It will delete the 
currently selected mail from the server. This is very useful to get rid of big emails that you do not want to 
download.
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View Menu

Hide

This command will hide the e-Mail notify main window. The icon in the tray bar of Windows 95 will still be 
available to control the notifier. This command is the same as double-clicking the system menu or clicking
the cross on the e-mail Notify window. This command has no effect if you are not running Windows 95.

ToolBar/StatusBar

These commands allow you to show or hide the ToolBar and/or StatusBar of the e-Mail Notify window. 
These settings are saved across sessions.

List View Font

Allows to change the font used to display messages in the List View. The settings are saved across 
sessions.
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Help Menu

Help Topics

Choose this menu item to open this file and get help on how to use e-Mail Notify. This command is also 
available in the Tray Menu.

World Wide Web Pages

In this popup menu, you will find some fast links to e-Mail Notify  ’  s Web site  . 

Registration

This menu can be used to find information on how to registerIDH_HELP_REGISTRATION or to apply the 
registration key.

About e-mail Notify

This menu item will give you a quick copyright information of e-Mail Notify. If you need more information 
please read the License Agreement. This command is also in the Tray Menu.
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Tray Icon and Menu
If you click on the e-Mail Notify Icon in the Tray Bar of Windows 95, you are going to unhide the main 
window of e-Mail Notify. This way you will be able to view the headers of the incoming mail. If you just 
stay over the icon without clicking, it will indicate you the state of e-Mail Notify. If you have sharp eyes, 
you will see the number of mail in the mailbox appearing on the icon when new mail is transferred.

You can access the Tray Menu if you are a Windows 95 user and click with the right button of your mouse
on the e-Mail Notify icon in the tray bar of Windows 95. For other users, this menu is also accessible has 
the last item of the System Menu. 

Help Topics

Choose this menu item to open this file and get help on how to use e-Mail Notify. This command is also 
available in the Help Menu.

About e-mail Notify

This menu item will give you a quick copyright information of e-Mail Notify. If you need more information 
please read the License Agreement. This command is also in the Help Menu.

Options

Choose this Menu Item to open the options Dialog Box, which will allow you to configure e-Mail Notify. 
This menu is also available in the Mail Menu.

Disable/Enable

This Menu command will allow you to enable or disable e-Mail Notify’s automatic mail checking option. It 
is the same as checking or unchecking this option in the Notify Tabof the options dialog box. This menu is 
also available in the Mail Menu.

Check Mail/Stop Mail Transfer

This Menu command will allow you to start or stop a Mail Transfer. This menu is also available in the  Mail
Menu.

Run External Reader

This Menu allows to start the external Mail reader as configured in the Reader Tab of the Options Dialog 
Box. This menu is also available in the Mail Menu.

Exit

Use this menu to close e-Mail Notify.



Run Multiple Configurations

To run multiple configurations and be able to check multiple mailboxes, just run multiple e-Mail Notify 
adding the “/Sn” switch.

If you add this Switch when Running e-Mail Notify, then it will run a specific configuration depending on 
the value of “n”. Not adding this switch uses default configuration “0”. This way you can run multiple 
instance of e-Mail Notify for different mailboxes you have. 

Example:

Run email /S0 and email /S1 will start two instances of    e-Mail Notify. Modifying options in any of these 
instances will not have any influence on the other instance or on the future instances of e-Mail Notify, 
unless they are ran with the same Settings Switch. 
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Special Features

This topic is to explain you some special behavior of e-Mail Notify.

First, when running in Windows 95, the only way to close e-Mail Notify, is to select the Exit Command in 
the File or Tray Menu. If you use other ways of closing e-Mail Notify, like the cross box in the e-Mail Notify
Windows or double-clicking the system menu, it will only hide e-Mail Notify. At this point, the application 
will still be active and can be controlled through the e-Mail Notify icon in the Tray Bar of the Windows 95 
Taskbar.

You can also activate the main window, if you click on the Notify Icon in the TaskBar.
For Windows or Windows NT users, the Tray Menu is also available as the last command of the System 
Menu, which offers a more convenient way to control e-Mail Notify under these systems.

Please consult the Run Multiple Configuration Topic for even more interesting information.
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Options Dialog Box - Server Tab

The options Dialog Box can be accessed from the Mail Menu or from the Tray Menu.
Click on the fields you need information about.

The following information can be set in this Tab:

POP3 Server
POP3 User Name
POP3 Password
Save Password
Ask Password at startup
Ask Password on each transfer
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Options Dialog Box - Checking Tab

The options Dialog Box can be accessed from the Mail Menu or from the Tray Menu.
Click on the fields you need information about.

The following information can be set in this Tab:

Check on Startup
Start Hidden
Automatic Checking
Checking Time Interval
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Options Dialog Box - Notify Tab

The options Dialog Box can be accessed from the Mail Menu or from the Tray Menu.
Click on the fields you need information about.

The following information can be set in this Tab:

Play wave on new mail
Wave filename
Browse for Wave file
Play Wave file
Speaker Beep
Message Box
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Options Dialog Box - Other Settings Tab

The options Dialog Box can be accessed from the Mail Menu or from the Tray Menu.
Click on the fields you need information about.

The following information can be set in this Tab:

Enable Logging
Verbose Logging
Log File Name
Browse for log file
Reset log file
Message Box on Errors
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Options Dialog Box - Mail Reader Tab

The options Dialog Box can be accessed from the Mail Menu or from the Tray Menu.
Click on the fields you need information about.

To pass the number of mails in your box to the spawned program, just add %n in the command-line where
you want the number of mail to appear. 
This option has been added because it gives the ability to write a program that will contact you when you 
have new mail through any way. One of theses ways could be a pager. If you are interested in such a 
feature, contact me and I might integrate the paging feature directly in e-Mail Notify.

The following information can be set in this Tab:

External Mail Reader
Browse for Mail Reader
Spawn Program on New Mail
Spawn Program not on First Transfer
Spawn Program File Name
Browse for Spawn Program
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Options Dialog Box - Remote Access Tab

The options Dialog Box can be accessed from the Mail Menu or from the Tray Menu.
Click on the fields you need information about.

This Tab only exist in the Windows 95 and Windows NT version.

To be sure an Dial-Up connection is not kept open by mistake, e-Mail Notify will stop mail checking after 7
minutes. If you plan to use e-Mail Notify Dial-Up Networking function will you are not at your computer, do 
not check the “Ask On Disconnect” option.

The following information can be set in this Tab:

Monitor Remote Access
Dial-In when not connected
Ask for Disconnection
Dial-In Interval
Remote Access Service
New Entry
Edit Entry
Log On As
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Click on the “Ok” Button to validate all changes you have made in the dialog and end the options session.



Click on the “Cancel” Button to cancel all changes you have made in the dialog and end the options 
session.



Click on the “Apply” Button to validate all changes you have made in the current Tab. Options session will
continue.



Click on the “Help” Button to get these Help pages ! 



The “AutoCheck” option tells e-Mail Notify to regularly check for changes in the mail box. You can change
the AutoCheck delay in the fields just below it. 



These fields are used to change the AutoCheck delay. Do not forget to activate AutoCheck by selecting 
the AutoCheck Check Box !



The “Check on Startup” option is a useful option, allowing e-Mail Notify to check in the mail box as soon 
as it is launched.



The “Start Hidden” option allows e-Mail Notify to start only with the Tray Icon in Windows 95.



The “Browse” button allows you to select a file using a Windows Standard Dialog Box.



Enter the file name which will be used to log requests. All request will be appended at the end of the file. 
You can use the Browse button to easily select a file.



Check “Log Request” to activate logging. All transactions will be fully logged and saved in the log file.



Check “Verbose” to activate verbose logging. More information will be saved in the log file.



Use “Reset Log” to delete the log file.



This options allows e-Mail Notify to open Message Boxes every time there are errors. Unchecking this 
option allows keeping e-Mail Notify open without being disturbed, even if the POP3 server is down or the 
Dial-Up connection not active.



Check this option if you do not have a Sound Card and want the speaker of you computer to beep when 
the mailbox changes.



This option is for users who have a sound card in their computer. Activate this option to have a Wave file 
played when mailbox changes.



Use this field to choose the Wave file to be played when mailbox state changes.



Use this button to test the Wave file you choose.



If you want a Message Box opened whenever the mailbox state changes, just check this option.



This field is used to enter the POP3 Server Name. 



This field is used to enter your POP3 User Name. It is usually the login name you use to logon on unix 
machines (if you have such an access).



This field is used to enter your POP3 Password. It is usually the password you use when you logon on 
unix machines (if you have such an access).



Check this option if you want your password to be remembered the next time you start e-Mail Notify. This 
option is useful for people running e-Mail Notify in a public place and do not want anybody running e-Mail 
Notify see their mail headers.



Check this option if you want e-Mail Notify to ask your POP3 Password at startup. If you check this option,
you should also uncheck the Save Password option.



Check this option if you want e-Mail Notify to ask for your POP3 Password when asking to view or delete 
mail. This way nobody will be able to use e-Mail Notify to read and delete your mails without knowing your
password. If you check this option, you should also uncheck the Save Password option.



Enter in this field the external mail program you want to be launched when you hit the “Run External Mail 
Program” Menu. Add any command line options that might be useful.



Enter in this box the command-line for the esternal program to be run any-time there is new mail.
If you add %n in the command-line, it will be replaced by the number of mails waiting in the box.



Check this box if you want an external program to be run any time there is new mail arriving.



Check this box if you do not want the external program to be run the first time you download mail.



Check this box if you want e-Mail Notify to check only when Remote Access Service is connected.



Check this box if you want to dial-in if Remote Access Service is not connected.



Check this box if you want e-Mail Notify to ask when willing to disconnect from Remote Access Service.



Choose the Remote Access Dial-In Interval used to check when Remote Access is not connected.



Choose the Remote Access Service e-Mail Notify should monitor.



You can create a new Remote Access entry using this button.



You can edit the current chosen Remote Access Service using this button.



Use this button to edit the User Name and Password used to connect to your Remote Access provider.



Enter the User Name used to log on your Internet Provider



Enter the Password used to log on your Internet Provider



Contact Information

There are three ways to contact me:

1. Electronic Mail

Take you e-mail client and send me a note at 
ldubost@pobox.com.

Since I get a lot of email about this program 
and have a full time job, please be aware that
I might take some time to answer your emails.
Here are the following subjects that you can use 
to speed up things:

REGISTRATION INFO:
for registration questions including site licenses etc..

REGISTRATION PROBLEM:
for registered users having problem to apply the key.

REGISTERED USER PROBLEM: 
for registered users having problems with email notify.

REGISTERED USER TIP:
for registered users proposing enhancements.

URGENT:
for urgent requests.

If you wish to contact me because you are 
having problems to setup e-Mail Notify please 
read the Trouble-Shooting section and the FAQ
 before sending me an email. If you believe you 
need to do so, please give me as much information 
as possible (log files, configuration information, 
detailed description of the problem, version used,
Operating System, TCP/IP stack).

Then keep e-mail notify on to wait on my response. 

2. World Wide Web

You will find my World Wide Web page 
at http://www.pobox.com/~ldubost/.
At this address, you will find information 
about me, the WebMeninges (WWW Master Mind) 
and information about new updates of e-mail notify.

3. Snail Mail

My snail mail address is:



Ludovic Dubost
9 Av. du Colonel Bonnet
75016 Paris, France
Tel: +33 1 42 30 90 69
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Register e-Mail Notify
Note: the Windows 3.1 versions are now provided free of charge. If you want to support shareware, you 
can still register e-Mail Notify. 

The Windows 95 and Windows NT versions of this program will be crippled after the 30 runs evaluation 
period. Automatic Checking/Quick View/Quick Delete will be disabled after this evaluation. When you 
register, you’ll get a key to unlock e-Mail Notify’s feature.

Registration Information is available online at 
http://www.pobox.com/~ldubost/english/notify/register.html
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Quickly Configure e-Mail Notify

Follow these instruction to configure e-Mail Notify.

1. Connect your computer to the Internet

2. Run e-Mail Notify.

3. Open the Options Dialog Box using the Mail/Options Menu.

4. Set your e-Mail account information 
      (Server Name, Login, Password).

5. Try to transfer mail using the Mail/Transfer Mail Menu.

If this procedure work, you can fine-tune the options to suit your needs.
If it doesn’t work, go to TroubleShooting.
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TroubleShoot e-Mail Notify

Note for Win32s and Win16 users: 
These two version have not been tested a lot and it is possible that they do not always behave properly. 
Thanks to e-mail from Win32s users I could already fix some bugs. If you experience problems using 
these versions, please send me information about it. Please log the notify session and send me the logs. 
This will really help me to make these versions work better.

If you have problems using e-Mail Notify, here is a simple procedure to check whether or not you 
misconfigured e-Mail Notify.

1. Use a ping program to see if you can access your e-mail server. Ping exactly the host you entered in 
the Options Dialog Box. If this is not working then you will have to check with your system administrator 
for access to this host.

2. Use a telnet program to connect to your e-Mail host with PORT 110. This will exactly reproduce what e-
Mail Notify is trying to do. The host should reply with a “OK+ ...” answer. If the connection fails then you 
will have to check with your system administrator.

3. While connected, send USER username and wait for a “OK+..” answer. Then type PASS password 
and wait for the “OK+” answer... If this procedure fails then you probably entered a wrong password.

4. If all the procedure worked as indicated, then there is probably an incompatibility between e-Mail Notify 
and your POP3 Server. Please contact me to give me more information.
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Start e-Mail Notify Hidden

To start e-Mail Notify hidden, check the “ Start Hidden”IDH_STARTHIDDEN option in the   “  Checking  ”   tab   
of the options dialog box.
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Download e-Mail Notify

You will find links to the current download site of e-Mail Notify on its web site at 
http://www.pobox.com/~ldubost/english/notify/download.html.

e-Mail Notify is also available on shareware sites like

Windows95.com at http://www.windows95.com/
CWSAPPS List at http//www.cwsapps.com/
TUCOWS at http://www.tocows.com/

See the e-Mail Notify Web Pages for a complete list of sites referencing e-Mail Notify.



Apply your Registration Key

Note for Win32s and Win16 users: 
This section doesn’t apply for the Win32s and Win16 version as these are provided free.

If you have received your registration key in your email here are
the instructions to apply the registration key without pain.

1. Save the body of the full e-Mail into a file. Ignore any attachement
that was send with it. Save the file in the e-Mail Notify directory.

2. Open the registration dialog box (from the Help/Registration menu or
the starting dialog box and copy paste your name and email from 
registration email.

3. Use the browse button the help you enter the path to your saved
registration mail.

4. Hit the “Apply Registration Key” button. e-Mail Notify will decrypt
the key and verify the name and email you entered. 

If you are getting a “Registration Failed” message, please check that
you have followed the steps properly and that you have type your name
and e-Mail properly.

If you are still having problems, send me an email with the subject
“REGISTRATION PROBLEM” and containing the registration file
you save in your e-Mail Notify directory and the name and email
you type in the registration dialog box. I will try to help you as fast
as I can.






